Every good tech should know Windows—and I don’t mean from a programming side, but rather from a user’s perspective. You are expected to be (eventually) the master or mistress of All Things That One Can Do on a Windows System. This includes skills such as moving and copying files, changing file associations, and using common shortcuts. We tend to ignore these more basic issues since we just assume that a person who replaces a hard drive also knows how to do these types of jobs. You need to be comfortable and confident with the Windows interface, or you will lose credibility as a tech. If you walk up to service a PC and have trouble moving or resizing a window, for example, this won’t instill a lot of confidence in your client!

The A+ Certification exam writers understand this, and they test you on Windows user-level stuff, such as file manipulation, shifting between open applications, accessing the proper toolbar to find formatting tools, and so on. While you probably already know much of this information, I’ve added this section for you to review and perhaps catch a few bits and pieces you might have missed along the way. Let’s start with a tour of the Windows 9x interface and then jump into the nitty gritty of working with Windows.
Touring Windows 9x

Don’t tell anybody, but I’ve always been a fan of Macintosh computers. I’ve found the Macintosh operating system’s interface easy to use and very intuitive. Back in the DOS days, I grimaced with envy when some pompous Mac-head performed with a few mouse clicks a procedure that took four or five disturbingly complex DOS commands. I stared in wide-eyed fascination as a Mac made my Windows 3.x interface look like a poor second cousin compared with the smooth animations of its operating system. Everything changed when I got my first copy of Windows 95. I fired up the system to stare in awe as I got my first view of what would soon make me forget all about the Macintosh: the Windows Desktop (Figure 1).

![Windows 95 Desktop](image)

**Figure 1** Windows 95 Desktop
For the first time in years, I could match—even beat—those smug Mac users to the productivity punch, leaving them in the dust as my intuitive, pre-emptive multitasking Windows smoked their Macs blow for blow. Oh, they yelled and protested and claimed that, “Microsoft just stole all these ideas from Apple!” To which I replied as innocently as possible, “Yeah? So what? I can load Word five times faster than you and with the same number of clicks!” They didn’t respond—there was no response. I haven’t really touched a Macintosh since. Revenge is sweet. Let’s take a look at the cornerstone of the Windows interface: the Desktop.

The Desktop

The Windows 9x Desktop is your primary interface to the computer. Using the desktop analogy appeals to most people—we’re used to sitting down at a desk to get things done. In the previous figure, we saw an example of a nice, clean Windows 95 Desktop. But you may add folders and files to the Desktop. Most people like to do so—certainly, I do! Just for fun, I’ve tossed in a screen snapshot of my Desktop from my home system—a Windows 2000 PC (Figure 2).

Gee, I’m about to show you how to move, copy, and delete both files and folders. Maybe I should put some of those skills to use on my system!

Taskbar and Start Menu

The taskbar, by default, runs along the bottom of all Windows 9x desktops. The taskbar handles a number of critical jobs, each of which takes a moment to appreciate. Although the taskbar by default sits at the bottom of the Desktop, you may move it to any side: top, bottom, left, or right. But for this section, let’s assume the taskbar sits on the bottom of the screen.

One of the main jobs of the taskbar is to show the Start button, probably the most clicked button on all Windows systems. When you look at the taskbar, you’ll notice the Start button on the far left (Figure 3).
Clicking the Start button opens the Start menu, which enables us to see all programs loaded on the system and to start them. Click on the Start button to bring up the Start menu. Now, move your mouse, but don’t click, up to Programs. As the mouse moves, notice how other menus appear. When the Programs menu appears, move the mouse to the Accessories menu. Locate the Notepad program and click it as shown here.

**Figure 2 Mike’s messy desktop**

Clicking the Start button opens the Start menu, which enables us to see all programs loaded on the system and to start them. Click on the Start button to bring up the Start menu. Now, move your mouse, but don’t click, up to Programs. As the mouse moves, notice how other menus appear. When the Programs menu appears, move the mouse to the Accessories menu. Locate the Notepad program and click it as shown here.
Later versions of Windows hide lesser-used menu options, so if you don’t see Notepad, click the double down-arrows at the bottom of the Accessories menu. Notepad will then appear.

**Windows General Rules of Clicking**

Since we have so much clicking to do in this chapter, let’s take a moment to reflect on what I lovingly call the “General Rules of Clicking.” There are a few exceptions, but these rules almost always apply and really help in manipulating the Windows interface to do whatever you need done.

- Click menu items once to use them.
- Click icons once to select them.
- Click icons twice to use them.
- Alternate-click on anything to see its properties.

Great! If you opened Notepad properly, you should see something like Figure 4, with Notepad displaying an untitled text page.
Notice how Notepad shows up on the taskbar at the bottom of the screen in Figure 4. Most running programs will appear on the taskbar in this way. Close the Notepad program by clicking on the button with the "X" in the upper-right corner of the Notepad window. Look again at the taskbar to see that Notepad no longer appears there.

Now look all the way to the right of the taskbar. We call this side of the taskbar the system tray. At the very least, you’ll see the current time in the system tray, although on most Windows systems, you also see a number of small icons. The following illustration shows the system tray on my PC.

These icons show programs running in the background. We often see icons for network status, volume controls, battery state (on laptops), and PC Card status (also usually on laptops). All kinds of icons show up here. What shows up on yours depends on your version of Windows, what hardware you use, and what programs you might have loaded. For example, my Symantec AntiVirus and System Monitor programs both have icons here. Every system will show different icons. You can double-click on them to see what they do.
If you have Windows 98/ME or Windows 2000, you also get the Quick Launch toolbar (shown in the following illustration). This handy extra enables you to select often-used programs instantly. You can easily add or remove programs, folders, and files to and from the Quick Launch toolbar by simply dragging them onto or off of it. We’ll see how to do this later.

![Quick Launch toolbar](image)

**My Computer**

My Computer provides access to all drives, folders, and files on the system. To open My Computer, simply double-click the My Computer icon on the Desktop. When first opened, My Computer shows you all the drives on the system (Figure 5).

![My Computer in Windows 98](image)

> The left side provides details of whatever icon you currently have highlighted. Microsoft calls this the *Web view*. For example, the previous figure has the C: drive highlighted, so the left side provides details about that drive. If you use Windows 95, or if you choose to turn off this option in Windows 98/ME or Windows 2000, you get a less sophisticated window that looks like Figure 6.
To view the contents of a drive or disk, double-click the corresponding icon in My Computer. Let’s say you want to see the contents of a floppy disk. You insert the floppy into the floppy drive and then double-click the floppy drive icon to see what’s inside. Here are the contents of a random floppy disk I had lying around (Figure 7).

Notice the different icons? Windows assigns different icons to different types of files based on their extensions. As you look at these icons, some of you might say, “But I don’t see any extensions!” That’s because Windows hides them. If you have Windows 95, click on View | Options to open the Options menu. Click the View tab and uncheck the Hide MS-DOS file extensions for file types that are registered check box. (While you’re there, let’s change one other item that will help later. Click the Show All Files radio button, too.) Suddenly, all the extensions appear. (See Figure 8.)
If you have Windows 98, it’s exactly the same process, except Windows 98 calls the Options menu the File Options menu. Windows 2000, of course, also has to do things a little differently. For Windows 2000, click Tools | Folder Options, and then click the View tab. We need to do three jobs here. First, click the Show hidden files and folders radio button; second, uncheck Hide file extensions for known file types; and third, uncheck Hide protected operating system files. Click the Reset All Folders button. A Windows 2000 View tab should look like Figure 9 when you are done. Do you see anything different from before? You should notice that all the file extensions have suddenly appeared! You may also notice some files or folders you didn’t see before.

Now close the floppy drive window just as we closed the Notepad window earlier. Hopefully, the My Computer window is still open. If not, just double-click the My Computer icon again. This time, let’s look at the contents of the C: drive. You definitely will see some folders here. Pick a folder and open it to see what’s inside. Great! You now know how to navigate around your computer using the My Computer icon. Close all the windows you opened to return to a plain Desktop.
My Documents

Windows 98 and Windows 2000 provide a special icon called My Documents. After Windows 95 came out, Microsoft discovered that users placed their files all over the system, and they often had trouble remembering where they’d put them! Microsoft recognized this issue and starting with Windows 98, created My Documents as a central default storage area for all files created by applications. Newer Windows programs, like Office 2000, store their files in My Documents unless you explicitly tell them to use a different folder.

Recycle Bin

We know from Chapter 8 that a file is not erased when you delete it. Windows 9x and Windows 2000 add an even higher level of protection in the form of the Recycle Bin. When you delete a file in Windows, a copy of the file moves into the Recycle Bin. It stays there until you empty the Recycle Bin, restore the folder or file, or until the Recycle Bin grows larger than a preset amount. To access these settings, alternate-click on the Recycle Bin and select Properties.
NOTE Everything in Windows has a properties setting which you can access by alternate-clicking and selecting Properties. From here on, when I say “access properties,” you know I mean to alternate-click and then select the word “Properties.” You may also access properties by highlighting the object and pressing ALT-ENTER.

Different versions of Windows Recycle Bin’s properties look very different, but they all basically work the same. Figure 10 shows the properties of a typical Windows 2000 Recycle Bin. Note that you set the amount of drive space to use for the Recycle Bin—10 percent being the default amount. If a hard drive starts to run low on space, this is one of the first places to check!

**Figure 10**
Windows 2000 Recycle Bin

---

**Network Neighborhood**

Systems tied to a network, either via a network cable or by a modem, have the Network Neighborhood or, as Windows 2000 calls it, My Network Places. The next illustration shows all the current network connections available to you. Let’s save Network Neighborhood for Chapter 20.
But wait, there’s more! These settings are only the most basic seen on a Windows Desktop; undoubtedly, the typical Windows system has many more items than these few. But for techs and for the A+ exam, that’s more than enough coverage of the Desktop.

**Working with Windows 9x**

No doubt, a person who supports Windows systems needs to know how to use Windows. But many new techs fail to realize that what they know as users often doesn’t help too much in their role as techs because our problems tend to show up in different areas. In particular, a Windows tech needs what I call “maneuvering skills.” We need to dance around the Windows directory structure and create, move, copy, and delete files and folders with the aplomb of surgeons. We need to know precisely the location of a number of critical utilities and know how to access them with or without a mouse. We need to understand the most critical files of the system, and while no one expects you to memorize all the settings in MSDOS.SYS or the Registry, you certainly should know how to edit them as needed.

The most powerful, and often the most difficult, aspect of maneuvering skills relies on the Windows tech not to fear “poking around.” The variances in Windows often require us to dive into folders, dialog boxes, programs, and Registry settings that take us out of a true comfort mode—we’re not sure exactly what to do or where to find something. A good tech understands this, knows how to poke around a system without causing damage, and knows how to get back to a stable scenario in case something goes wrong—and things will go wrong!

U.S. President Franklin Delano Roosevelt once said, “The only thing we have to fear is fear itself.” I wish I could write that quote on the back of every PC technician’s hand! Unlike users, we do not get the option of throwing up our hands when the PC fails to run properly. We must use maneuvering skills combined with basic system knowledge to find the answer. Newer techs will respond to this concept with, “What if I break it worse?” You will, sometimes! As a PC tech with roughly 15 years’ experience, I estimate that I have personally destroyed close to $500,000 worth of hardware and have lost multiple terabytes of data. It happens. It goes with the job. In return for that destruc-
tion, I have also fixed many thousands of systems, recovered 1,000 times as much data as I ever lost, saved companies, saved jobs, and saved many millions of dollars for my customers and my employers. Welcome to the club! By the way, if we ever meet face to face, buy me a Guinness Stout or two and ask me about the “ProPrinter Stampede” or the “Gas plant flood of ’82.” I’ve got some great stories!

Enough of this soapbox! Let’s get some maneuvering skills!

NOTE Windows provides multiple methods for almost any task. I won’t show you every way to do everything—just what I feel are the best methods for handling a particular procedure.

Let’s begin with the most basic of maneuvering skills—maneuvering Windows. The A+ exam really hits on this area and it trips up everyone. Many of the steps you and I take daily we don’t really think about, as we repeat these steps so often we do them more subconsciously than consciously. That’s fine for day-to-day system support, but you’ll find yourself staring blankly at a screen when the A+ test asks, “Given XXXX scenario, which hot-key combination would best enable you to do YYYYY?”

TIP Know your shortcut keys! You should know how to run Windows completely without a mouse! You never know when you’ll need to work on a system whose mouse just died!

So, as Mary Poppins said, “The best place to start is at the beginning.” Let’s look at a basic window.

The Basic Window
All Windows 9x windows contain roughly the same tools. Figure 11 shows a generic window. Let’s make sure we know all these components. If you’d like, fire up Notepad and follow along!

Window States
A window must be in one of three states: windowed, full-screen (maximized), or minimized. The preceding figure shows the window in the windowed state. To make the window full-screen, click the Maximize button (the box icon in the top-right corner of the window). Figure 12 shows the result.
Figure 11
Windows “window tools”

Figure 12
Full-screen window
Notice that the Maximize button has disappeared and has been replaced by the Restore button—it looks like two little overlapping windows. Click that to return to the windowed state.

Now minimize the window by clicking the Minimize button, the icon with a single horizontal line. Note that the window disappears, but you still see the program on the taskbar. Click the program listing on the taskbar to bring the window back. Close the window by clicking the Close button, the X icon. You can also close any active window by simply pressing ALT-F4.

Windows provides other methods to change a window’s state. Click the program icon in the upper-left corner to see what Microsoft calls the context menu, as shown next. You may also bring up this menu by clicking ALT-SPACEBAR or by alternate-clicking on the window’s taskbar listing.

**Moving Windows**

Use the title bar to move a window. Just move the mouse anywhere over the title bar and drag it around. You can also move a window without using a mouse. Press ALT-SPACEBAR to bring up the context menu, use the DOWN ARROW key to select Move, and press ENTER. Use the arrow keys on the keyboard to move the window. You see the outline of the window as you move it. Press ENTER when you finish moving the window to see it in its new location (Figure 13).

Try this shortcut: press CTRL-ESC to open the Start menu. If you have a Windows keyboard, you may have a special Windows key that also enables you to open the Start menu. Now press ESC—notice that the Start menu disappears, but the Start button is selected. Press TAB once or twice to move the focus to the taskbar, then use the LEFT ARROW and RIGHT ARROW keys to select the program on the taskbar.
Once you select the program on the taskbar, press SHIFT-F10 to bring up the shortcut menu for the selected item, and move using the arrow keys as previously described. Note that most applications have a Move option on the shortcut menu, although you will occasionally run into some that do not. We use this “no mouse move” technique to retrieve a window that manages to completely move itself out of view of the Desktop. This technique may take a bit of practice—learn it.
Resizing a Window

We often like to change the size of a window. We use the window’s borders to resize it. Move the mouse to the border on any side until the cursor changes to a double arrow.

Then drag to move that side. You may also move the mouse cursor to any corner to move the two adjoining sides at once. Look for the cursor to change to a diagonal double arrow, and then drag as before.

Menus

Virtually every window uses a menu. Each menu varies from program to program, so my only real motivation here is accessing a menu without a mouse. Select the window and look at the menu. Notice the underlined letters in the menu?

Hold down the ALT key and press the letter of the menu option you wish to use. For example, to open the File menu, press ALT-F. You can then use the UP ARROW and DOWN ARROW keys to select the menu item and press ENTER, or you may press SHIFT and the underlined letter. Know both of these methods.
While we’re on the subject of no mouse, you can use the TAB key to move around inside a window once you’ve selected the menu option as just described. A good tech should be able to access any menu, program, toolbar or windows option without using a mouse.

**Toolbars**

Toolbars are nearly as common as menus. Toolbars provide application-specific functions. While Windows menus vary, you may notice that they all have certain commands in common—File, Edit, View, and so on. Different applications’ toolbars will vary tremendously.

To add to the confusion, how toolbars act depends heavily on the version of Windows installed and what applications you install! The basic Windows 95 toolbars are very static—that is, you can’t move them or change them. But if you have installed Windows 98, Windows 2000, or more advanced applications such as Internet Explorer 5 or Office 97, you get very powerful, flexible toolbars. It’s easy to tell what type of tools a particular window provides—just look on the far left side of the toolbars for small vertical bars, as shown in Figure 14.

*Figure 14  Advanced toolbar from Windows 98*
You move these toolbars by simply dragging them around. A toolbar may be free-standing or snapped to any side of a window. Most of these toolbars can move completely outside the window if desired. Users often accidentally move these toolbars and think something has messed up badly!

Most applications enjoy substantial flexibility with their toolbars. Try alternate-clicking in a blank area in any toolbar to see what options appear, as shown in Figure 15. While the options vary among different Windows versions and applications, you can always alternate-click to see what you may change.

![Figure 15](image)

**Figure 15**
Alternate-clicking on a Windows 98 My Computer toolbar

---

**Multiple Windows**

The single greatest feature of all versions of Windows centers on the multitasking capabilities. Running multiple programs in multiple windows enables you to do some very cool things. With multiple windows, for example, you can minimize a web browser so that it may open instantly when needed. You can drag and drop text and graphics between applications. You can even copy and move files and folders between two open windows. Multiple windows make Windows fun to use, but they also make system use a little messy. Let’s turn now to navigating around multiple windows.
Too Many Windows!

Using My Computer exposes a serious downside: by default, every time you open a folder, it opens a new window. While sometimes this is great, most of the time it is simply frustrating (Figure 16).

You can turn this feature off by selecting View | Folder Options and changing the radio button selection in the Folder tab. (Different versions of Windows move things around, so you might have to hunt through the Folder Options to find the proper radio button.)
Active/Inactive Windows

When you open multiple windows, the window “on top” is called the active window. Windows does a nice job of showing the active window by changing the colors of any windows behind the active window—we call those windows inactive.

You can look on the taskbar to determine the active window. Note how one program’s listing looks different from the others shown here? That’s the active program.

Inactive Windows       Active Window

We make an inactive program active by clicking on the window. Try to avoid clicking on a menu item or other control, because the window will not only become active, but will also act on whatever you clicked. Pick a nice blank area.

I like to click on the window listing on the taskbar to make the program active. This will open even a minimized window.
Windows Shortcuts

Windows provides a number of handy keyboard shortcuts that allow us to switch quickly between applications. Know these shortcuts!

NOTE  All of these shortcuts work with Windows 2000.

ALT-TAB

This brings up a small window that enables you to choose from all running programs. Hold down the ALT key, and press TAB repeatedly to cycle through all running programs. Release the keys after selecting the program to make it active. If you select a minimized program, Windows restores the program.
ALT-ESC
This shortcut cycles around all windows, including minimized ones, but does not open minimized windows.

CTRL-ESC
This opens the Start menu.

CTRL-ALT-DEL
This brings up the Task Manager. The Task Manager shows all running programs, including any programs running in the background (like antivirus programs). The Task Manager is our first line of defense for shutting down frozen applications. When an application freezes, the Task Manager shows a “program not responding” message.

To close the program, select it in the list and select the End Task button. This successfully closes the frozen program—most of the time.

Pressing CTRL-ALT-DEL in Windows 2000 brings up the Security window. Just click the Task Manager button to get the Task Manager.
Windows Enhanced Keyboard Shortcuts

Those of you lucky enough to have a Windows keyboard get some extra keys. The two most common are the Windows logo key (WIN key) and the MENU key. Look at Figure 17. The key on the left is the WIN key—the one on the right is the MENU key.

These keys, either alone or in combination with other keys, give a number of very handy shortcuts. Here are a few of my favorites:

- **WIN**  This opens the Start menu—very handy.
- **MENU** This opens the default pop-up menu for that window. Usefulness varies by application.
- **WIN-TAB** This shortcut cycles around all windows, including minimized ones, but does not open minimized windows. It is identical to ALT-ESC.
• WIN-M  This is one of the most underutilized of all Windows shortcuts. This mini-
imizes all windows. Very handy for getting all open windows out of the way. Win-
dows 98 and Windows 2000 users get the Show Desktop icon on the Quick
Launch toolbar on the taskbar which accomplishes the same thing.

While minimizing all windows is really useful, so is pressing SHIFT-WIN-M, Undo Min-
imize All. This automatically restores all the windows to the position they were in
before you minimized them. I use this minimize/undo minimize constantly!

Practice
Now you just need to put these concepts into practice. If you’d like a more extensive list
of keyboard shortcuts, including some for Windows Explorer and Internet Explorer,
check out the Microsoft web site www.microsoft.com, and do a search for document
Q126449 or for “Keyboard Shortcuts for Windows.”

Manipulating Files and Folders
A Windows tech must possess substantial file and folder manipulation skills. We con-
stantly need to move, copy, and delete both files and folders. Fortunately, compared
with DOS, Windows provides handy procedures that make this very easy. For our first
sojourn into these procedures, let’s use My Computer, although Windows Explorer
works just as well.

Selecting Items
We rarely want to copy, move, or delete just one file or folder, so Windows provides
many methods to select multiple items. First, you can click and hold down the primary
(left) mouse button, and then drag the cursor over items you wish to select. To select
multiple (rather than single) files, you must click on a blank area, not directly on a file-
name or icon, and then drag the cursor. Windows will display a dotted selection box
and highlight the chosen files to show you that you are doing it properly. Figure 18
shows a selection in progress.
Figure 18
Selecting multiple files by dragging the cursor

You can use the CTRL key to select or deselect individual items. Just hold down the key and click (Figure 19).

You can use the SHIFT key to select or deselect blocks of items. Just click the first item, and then hold down the SHIFT key and click on the last item (Figure 20).

Finally, click CTRL-A to select all items—my personal favorite!

Moving and Copying
Insert a blank floppy disk and open My Computer. Click on the floppy drive icon to open a window, and then go back to My Computer and open a window for the C: drive. Move and resize the two windows to look like Figure 21. Got it? Great! Follow these rules and you’ll have no problems moving and copying files!

Mike’s Copy/Move Rules for Files and Folders
• To copy between drive letters, just drag whatever you wish to copy from one folder’s window to the other.
• To move between drive letters, hold down the SHIFT key while dragging.
• To move within the same drive letter, just drag from one window to the other.
• To copy within the same drive letter, hold down the CTRL key while dragging.
Figure 19
Individual items selected using the CTRL key

Figure 20
Use the SHIFT key to select blocks of items
Figure 21  Initial setup for moving or copying

The best way to learn this is by practice. Try dragging a TXT file from the C: drive to the floppy. Do you see the little plus “+” sign as shown in Figure 22? Great, that’s how you know you are copying! Do it again except this time hold down the SHIFT key. Notice that the plus sign has disappeared? Great, now you’re moving!

Now go back to My Computer again. This time open the C:\WINDOWS folder. Move and resize the windows so they look like the windows as shown in Figure 23. Notice that the figure shows the C:\WINDOWS folder open.

Try dragging the text file from the floppy to the C:\WINDOWS folder. Notice the plus sign has reappeared. Now drag the file from the C:\WINDOWS folder to the C: folder. Hey! No plus sign! Hold down the CTRL key to make it appear.

If you’re feeling lucky, try copying or moving folders. Just don’t mess with any important folders! I’ll show you how to make folders in a moment.
Find/Search

Let's find the Notepad.exe program. Click on Find from the Start menu (Windows 2000 calls it Search), and then select Files Or Folders to see the search menu appear. Windows 2000 looks a little different, but they all work the same. Show me some manipulative skills! Make sure that the Look In pull-down menu says “C: drive.”
Type Notepad.exe in the search field, and click the Find Now (Search Now) button. After a lot of grinding, Windows will find Notepad.exe (Figure 24). If it doesn’t, try looking on your D: drive—better yet, tell it to look in the \WINDOWS folder or \WINNT folder (if you have Windows 2000).

Take a moment to look at some of the features of the Find/Search program. Can you see how to search by date and size? Notice the Containing Text option—this is a powerful tool! I use it daily.

Just for fun, try another search: this time just type in notepad without the .exe. Run the search—you get everything with the word “notepad”! (See Figure 25.)
Figure 24  Search results for Notepad.exe

Figure 25  Search results for “notepad”
Remember wildcards from Chapter 9? Try searching on *.ini to see how many INI files your system stores (Figure 26, above). Finally, click the column headers to sort the files by name, folder, or size (Figure 27). Do another search for Notepad.exe and read on.

**Shortcuts**
Drag Notepad.exe from the search window onto the Desktop. Be careful—don’t drag it on top of another icon like My Computer, just into a blank area like you can see here.

Notice the small arrow on the icon? Windows thinks you want to copy a shortcut. Shortcuts are not the real file—they only point to the real file. Why make a second copy
of Notepad when we can just make a tiny file that points to it? Shortcuts work just like programs—double-click on the Notepad shortcut to start Notepad.

You can copy and move shortcuts just like any other file. All the previous rules still apply. Now drag the shortcut onto the Quick Launch bar (if you have one); Windows adds Notepad to the bar—nice! Change your mind? Then drag it off.

Shortcuts are not limited to programs. You can make shortcuts to files or folders. Just drag the folder or file to wherever you want the shortcut while holding down the ALT key. I store lots of data on my D:\DATA drive, so I used My Computer to create a shortcut to D:\DATA on my Desktop.
Creating Files and Folders

Creating new folders and files is almost too easy. Just go to the location where you want to make the new item, and alternate-click in a blank area. Everybody likes to make folders on the Desktop. Find a blank area on the Desktop and alternate-click. Select New | Folder.

A new folder appears on the desktop. Notice the name—New Folder. Notice how the name is highlighted? Windows wants you to give it another name. Type in a new name—call it Fred.

Take a moment to open Windows Explorer and find the \WINDOWS\DESKTOP folder. You’ll see \FRED.
We can make files in the same way, but we rarely do so since the applications themselves make new files when we save them. Save the New option for making folders. This works everywhere in Windows. Try making a new folder in the FRED folder. Try making a folder on the floppy disk using My Computer. Open Windows Explorer and make folders from there! It always works—just be sure to click on a blank area. Both My Computer and Windows Explorer also provide a menu option for the New command. Just click File | New to get the same option.

Hey, before you go any further, jump back to the move and copy section, and try moving and copying some of the folders you made. All the rules for moving and copying files apply to folders, too.

Deleting

Deleting is dangerously easy. Just select what you want to delete and press the DEL key. Windows will at least give you a warning before it dumps the item into the Recycle Bin.
You don’t need to empty a folder to delete it. You can even delete hidden, system, and read-only files, although again, Windows gives a warning.

If you want to delete something permanently, hold down the `SHIFT` key when you press `DEL`, but be careful with that one! Unless you have an undelete program of some type, it’s gone. Note that this dialog box does not ask if you want to send to the Recycle Bin.

Thank goodness for the Recycle Bin—it saves me at least once a week!

**Renaming**

Renaming is just as easy as deleting. Just select the item you wish to rename and press `F2` to rename it. While renaming is quite easy, it also can be quite hazardous. Remember the beginning of the Windows 95 section? Remember that I had you show the file extensions? Watch this—make a new TXT file called `FRED.TXT` on the Desktop. (Alternate-click on the Desktop, select New | Text Document.) Change its name to `FRED.SYS`. Windows doesn’t like that!
Now you know why Windows doesn’t like to show extensions! Windows uses the extension to determine the type of program that opens the file, just as we did in DOS. We call this the *association*, and I’ll show you how to deal with this in a moment.

**Properties/Attributes**

Like everything in Windows, files and folders also have properties. Earlier, I showed you one way to access properties. Now here’s another: hold down the *ALT* key and double-click the item. You learn a lot about a file or folder from its properties. Ever wondered to yourself, “How much hard drive space will I open up if I delete this folder?” The folder’s properties will tell you. Would you like to know who wrote a certain program? The program file’s properties show this information. Some programs such as Microsoft Office use the properties screen to show very detailed information. Figure 28 shows some of the property information on a PowerPoint presentation I’ve used for years.

![Figure 28](image.png)

*Figure 28*  
Summary properties of a file
Remember that we use properties for files and folders to set their attributes. Figure 29 displays the attributes for the IO.SYS folder.

![Figure 29](image)

**Figure 29**

IO.SYS folder attributes

---

**NOTE** Whenever the A+ exam starts asking about an aspect of a particular item—its color, size, date, owner, configuration, resources, whatever—you can bet the place to look is in the properties!

---

**Cutting and Pasting**

While I prefer to manipulate files and folders by dragging and dropping, the A+ exam expects you to know how to use cut and paste to handle them. I do use this technique; in certain cases it makes life much easier. Let’s take a look at cut and paste.

For cut and paste, I will use Windows Explorer. However, this technique works just as well everywhere else in Windows.

The foundation of cut and paste is centered on the Windows Clipboard. The Windows Clipboard is a temporary storage area in RAM into which you may place anything—a folder, 1 or 100 files, a piece of text, a picture, an e-mail—virtually anything.
that is part of Windows can be placed into the Clipboard. We put copies of items into the Clipboard by selecting them and then pressing CTRL-C (copy). If we want to move something out of where it is and into the Clipboard, we select the item(s) and press CTRL-X (cut). If we want to take something out of the Clipboard and put it someplace else, we go to that other place and then press CTRL-V (paste). Almost every version of Windows provides menu support for cut and paste under the Edit menu. You may use either method—just know both of them!

**Mike's Cut and Paste Rules**

- Select something.
- If you want to move it, cut it (CTRL-X).
- If you want to copy it, copy it (CTRL-C).
- Open up whatever you want to put it in and paste it (CTRL-V).

Let's say I have a system with drives C: and D:. I want to put a copy of a folder called C:\DATA\BOOKS3 into a folder called D:\BACKUP. Using Windows Explorer, I first select the C:\DATA\BOOKS3 folder. It doesn’t matter whether you open it or keep it closed (Figure 30).

I want to copy it, so I press CTRL-C. Nothing obvious happens. Good. I then move to the D:\BACKUP folder and press CTRL-V. Suddenly, the entire folder appears (Figure 31).

It’s really that easy, but let’s do it again just for fun. This time I want to move three files called HUEY.DOC, DUEY.DOC, and LOUIE.DOC off of my Desktop and onto the floppy drive. First I go to C:\WINDOWS\DESKTOP and select the three files. I use the CTRL key to select them (Figure 32). I then press CTRL-X since I want to move them.

Notice that the files still appear but are shadowed to show they’ve been cut to the Clipboard. We then go to the floppy drive and press CTRL-V to paste them (Figure 33).
Figure 30
Selecting the folder to copy

Figure 31
Pasting the folder to copy
Figure 32
Selecting multiple files to cut

Figure 33
Files pasted to the floppy drive under Windows Explorer
The Windows 9x and Windows 2000 clipboards only hold one piece of data. If you cut one file and then cut another, the first one is gone. Newer applications such as Microsoft’s Office 2000 have much more powerful clipboards that support up to 12 items, but they are of no use unless you’re in an office document. Let’s see if Microsoft adds it to the next version of Windows.

**File Associations**

Earlier sections of this chapter gave us some idea as to how Windows knows which program to use to start a particular data file. We know Windows uses the extensions to create some type of association between the files that use that extension and a particular program, but how? The secret lies deep in the Windows Registry. Windows stores information on every type of file extension it knows about in the Registry under the HKEY_CLASSES_ROOT. Let’s take a peek at how this works using the Registry Editor program (REGEDIT) from a command prompt.

First, the Registry identifies the extension with an alias. We see here that the TXT extension is identified—“associated,” as Microsoft wants us to say—with the alias “txtfile” (Figure 34).

We now scroll through HKEY_CLASSES_ROOT to find the entry for txtfile. Thankfully, they’re in alphabetical order. Here it is! (See Figure 35.)

We see some interesting settings here. First, notice the term “Text Document”—you’ll see this again soon. Below the listing txtfile, we see two folders called DefaultIcon and shell. DefaultIcon just tells which file to open for the icon (Figure 36).
Notice the setting “shell32.dll,-152.” This DLL is a veritable treasure trove of icons. The number -152 tells Windows which icon to use. The shell folder holds values that appear when a file of this type is opened by double-clicking or if the file is alternate-clicked (Figure 37). The two subfolders are open and print.
These aren’t *all* the settings you see when you alternate-click. Windows provides a number of default alternate-click options (like *properties*), but these two options are the ones unique to this type of file.

Notice that underneath each command in the Registry is another folder called *command* that tells Windows what to do when one of these options is selected. Whenever you double-click on a file, it immediately tries to run the Open command. The Open command is set to `C:\WINDOWS\NOTEPAD.EXE %1`. Windows goes to a C: prompt and types the command:

```
C:\WINDOWS\NOTEPAD.EXE <name of the text file that you double-clicked on>
```
If the text file was called FRED.TXT and its path was C:\WINDOWS\DESKTOP, then the command is C:\WINDOWS\NOTEPAD.EXE C:\WINDOWS\DESKTOP\FRED.TXT. That’s how programs become associated with extensions. Kinda cool!

So who creates associations? Windows itself creates quite a few critical (although not very well-known) associations, but the majority of associations that most concern us come from applications we install. Installing Microsoft Office, for example, makes about 12 new associations—from associating DOC extensions with Microsoft Word to XLS files with Microsoft Excel. Most programs will even try to grab an extension already used by another program. Ever seen a program say something like this?

This message really says, “Hey! Some other program has my data type’s extension associated! Can I take it back?”

All of this automation means we rarely need to edit associations manually; however, two situations exist where we find manual associating necessary. Sometimes we want to associate a program with an extension it doesn’t normally want to associate with, such as associating INI files with Notepad to make them easy to edit. Sometimes we want to remove an association that we no longer wish to use, like an uninstalled program that didn’t remove the association.

So, ready to edit the Registry manually to add or to edit a file association? No? Neither am I! Windows provides a handy tool to allow us to create, edit, or delete file associations. In Windows 9x, open My Computer, click View | Options (Folder Options in 98), and then select the File Types tab. In Windows 2000, open My Computer, click Tools | Folder Options, and then select the File Types tab. The Windows 98 File Types folder looks like Figure 38.

Let’s create a real-world motivation for using this tool. My friend Martin installed Paint Shop Pro, the popular graphical editing program, a while back. At install, the program gave him a bunch of graphic file extensions for associations, but he didn’t take the Windows BMP graphical format. His young daughter liked drawing pretty pictures in MSPaint, the little paint program that comes with every version of Windows. Windows associates BMP files with MS Paint when you install Windows. His daughter left all her pictures on the Desktop, and she knew how to double-click on a BMP file to work on a particular piece of art in MSPaint.
One day his daughter got her own PC. A few days later, I handed Martin about 34 BMP files I made in 1995 and told him I needed a number of changes made. Martin now would very much like to associate BMPs with Paint Shop Pro. Let’s do it for him.

First, scroll through the list of file types in the Folder Options until you find the BMP file type. The name of the file type doesn’t always give a good clue as to the extension, so we need to watch the file details as we scroll. Figure 39 shows the BMP file type—note Windows just called it a “Bitmap Image”—sometimes finding the right extension is a chore! If we want to delete the association, we simply need to click the Remove button and it’s gone. Equally, we just need to click New Type to create a new association.

Clicking the Edit button opens the Edit File Type dialog box, which shows the different commands that this association provides. (In Windows 2000, click the Advanced button to get the same information.) Note the Actions list—you may create multiple actions to place on an extension. Note that the open command is in bold—that’s the default command, the one that happens when you double-click. We could easily select the print option and use Set Default to make print the default option. Every time a person double-clicked on a BMP file, it would print! Probably not a good idea. While you can really do some neat commands here, the A+ exam only really wants you to understand where to deal with associations, not necessarily every aspect of associations.
In the Edit File Type dialog box, select the **open** command and click the Edit button to see this dialog box.

This line just says to open with MSPaint. The “%1” enables you to select multiple files to open with one click. Just click Browse to find the Paint Shop Pro program. Fortunately, I know exactly where it is, so I’ll just use Browse to go to the PSP.EXE program and select it to get something like this.
Must . . . Keep . . . Control . . .
This short section on file management just covers the basics you need to pass the A+ Certification exams—barely. What this text does not cover are the many ways the exams might toss questions out at you. That requires some practice on your part. Make sure you can change the name and attributes of any file or folder. Test your skills navigating throughout the system, including CD-ROMs and floppy drives. See that you understand how to delete, move, or copy any file or folder. Work with the toolbars and menus in Windows—especially under My Computer and Windows Explorer—and learn how to change views, sort, and set window options. And make sure you know your shortcut keys. The secret to PC support is file manipulation. It’s how we keep control of those masses of files and folders throughout your system.

Control Panel
The rest of this chapter dedicates itself to a tour of a very important part of Windows for techs: the Control Panel. The Control Panel handles most of the maintenance, upgrade, and configuration aspects of Windows. Click on Start | Settings | Control Panel to open the Control Panel (Figure 40).

A large number of programs, called applets, populate the Control Panel. The names and number of applets vary among versions of Windows and according to whether any installed programs added applets. But all versions of Windows share most of the same applets.

The printed part of this book covers every applet essential for techs to know in chapters that pertain to the applet. I’ve assembled a more detailed list of all the common applets here as a handy reference for you.
NOTE  Even these common applets may vary slightly between Windows versions. The A+ Certification exams do not test you on every little variance between the same applets in different versions—just know what each applet does!

**Accessibility Options**

Accessibility Options provides a number of extra functions to assist physically challenged individuals with using the PC (Figure 41).

Here is a list of some of the options in Accessibility Options:

- **StickyKeys**  Enables you to perform key combinations one key at a time
- **FilterKeys**  Ignores brief and repeated keystrokes
- **ToggleKeys**  Makes sounds when CTRL LOCK, NUM LOCK, or SCROLL LOCK are pressed
- **SoundSentry**  Makes the system flash borders or windows when the system creates a sound
- **ShowSounds**  Creates captions for sounds
Figure 41
Accessibility Options

- **High Contrast**  Sets the display to high contrast
- **MouseKeys**  Lets you use the arrow keys to control the mouse cursor

**Add New Hardware**
The Add New Hardware applet provides a step-by-step process (often called a wizard) to allow you to install devices that your Plug and Play does not support (Figure 42).

We use the Add New Hardware Wizard to install legacy devices or if the Plug and Play has a problem such as no driver or a resource conflict. In some versions of Windows, this wizard may start automatically if the PnP cannot find a valid INF file for the detected device.

**Add/Remove Programs**
This applet’s original function was to assist in both adding and uninstalling applications (Figure 43).

Every Windows install program now provides some level of uninstall function, however, making the install aspect rarely used. One aspect of Add/Remove programs that comes in handy is the ability to remove or modify components of installed applications, rather than simply removing the whole program. This applet also enables you to add/remove Windows components and create a startup disk.
Date/Time
This sets the system date, time, and time zone (Figure 44). You can also set the date and time by double-clicking on the clock on the taskbar or by accessing a command prompt and typing in the DATE and TIME commands.
Display
The Display applet handles almost all display functions (Figure 45). You may also access this applet by alternate-clicking on any unused area on the Desktop and selecting Properties.

Most of the tabs in the Display Properties applet are fairly obvious. The Background tab enables you to choose a background picture or pattern. The Screen Saver tab has settings for choosing and configuring a screen saver. The Appearance tab provides various color schemes. The Effects tab enables you to change the look and effects of Desktop icons, animations, and font quality. The Web tab enables you to activate the Active Desktop, making your Desktop in essence a web browser. Neither the Effects tab nor the Web tab is available in Windows 95.

The tab of most interest to PC techs is the Settings tab. Here you set the color depth and resolution of the display, change video card and monitor drivers, and set the video refresh rate.

Fonts
This applet is really just a shortcut to the \WINDOWS\FONTS folder (Figure 46).

The Fonts applet shows all installed fonts and provides a method to install or remove fonts from the system.
Figure 45  
Display Properties applet

Figure 46  
Fonts applet
Game Controllers
The Game Controllers applet supports joysticks or one of the many other game devices that use the joystick port, such as game throttles and game steering wheels (Figure 47). You use this applet to calibrate and test a newly installed joystick.

![Game Controllers applet](image)

Internet Options
The Internet Options applet (just called Internet in Windows 95) configures the settings for the web browser. You can also access this option from within the web browser (Figure 48). Note that double-clicking the Internet Options applet opens the Internet Properties dialog box.

This applet enables you to set up an Internet connection, specify a home page, and modify the History, Web cache, and Cookies settings, as well as a number of other things. When a browser doesn’t browse, this is one of the first places to check.
Keyboard
The Keyboard applet defines all configurable keyboard settings (Figure 49).

Have you ever held down a key for a few seconds until the character starts to type itself multiple times? This applet sets (1) how long to wait before repeating (Repeat Delay), and (2) how quickly to repeat the character (Repeat Rate). We also configure the system to accept different keyboard layouts.

Modems
This applet installs, configures, and tests modems (Figure 50). If you don't have a modem, this applet starts the Modem Install Wizard.

The Modems applet enables you to set the modem driver, the COM port, and a number of other important modem settings. The most powerful feature is the Diagnostics tab, which queries the modem for information. While the information returned is often useless to all but the most sophisticated techs, the fact that the modem responds to the query is a great indicator that the modem is in good working order and is properly configured.
Figure 49
Keyboard applet

Figure 50
Modems applet
Mouse
The Mouse applet configures the mouse (Figure 51).

Too many techs overlook this applet, especially to support newer PC users. Here you can change the speed of the mouse, adjust the double-click rate, modify the mouse pointers, and set up the mouse for left- or right-hand function.

Multimedia
Multimedia configures the system’s audio and video settings (Figure 52). (Windows 2000 combines this applet with the Sounds applet into the Sounds and Multimedia applet.)

Until we get into Chapters 15 and 16 of A+ All-in-One Certification Exam Guide, Third Edition, there’s not a lot I can discuss here without going into great depth. We’ll see this applet again!

Network
This applet configures all network functions. We can also access this applet through the Network Neighborhood (My Network Places in Windows 2000) properties (Figure 53).

Like the Multimedia applet, the Network applet requires substantial discussion to appreciate all it does. Let’s save that discussion for Chapter 20.
**Figure 52**  
Multimedia applet

**Figure 53**  
Network applet
ODBC Data Source Administrator
ODBC stands for open database connectivity, a standardized method to enable any application to access any data source, as long as both the application and data source follow the ODBC standards. The ODBC Data Source Administrator applet stores information about all ODBC-compliant databases on a system, which enables ODBC-compliant applications to access them. Most PC techs rarely access this applet (Figure 54).

Passwords
The Passwords applet enables you to set and change passwords—which is rather logical—for multiple users of a single machine (Figure 55). When you log in for the first time after enabling this feature, Windows makes a user profile for you that includes desktop icons, color scheme, and other personal settings. Other people can log in as well and have their own personalized settings. Chapter 18 explores user profiles in more detail. Windows 98 SE introduced other features into this applet, such as the ability to configure remote connectivity to your machine. Chapter 20 discusses networking issues such as remote access of resources.
Power Management
This applet enables you to set many power management settings. Windows 95 just calls this applet Power (Figure 56). You can configure basic power settings such as how long to wait before the monitor shuts off. We will discuss power management in more detail in Chapter 18.

Printers
If it has to do with a printer, the Printer applet does the job. Every version of Windows provides many other methods to access this applet. The most common way to access this applet is by opening My Computer. The main window shows the installed printers and the Add Printer Wizard (Figure 57).
You can open a printer to see its current status.
You can access printer configuration information as well by selecting printer properties (Figure 58).

Finally, you can use this applet to add and delete printers, and troubleshoot if a printer refuses to print. We'll return to printers and the Printers applet in Chapter 19.
**Figure 57**
Printers applet

**Figure 58**
Printer Properties
Regional Settings
The Regional Settings applet provides formatting options for currency, numbering, date, and time for different regions. Programs that know to look here set themselves up according to these settings (Figure 59).

sounds
The Sounds applet enables you to apply sounds to different system events (Figure 60). Applying sounds to system events reminds me of shaving—it’s really fun the first three times, but after that it quickly becomes tiresome. By default, this application looks for WAV files (Microsoft sound files) in the \WINDOWS\MEDIA folder, but you may also browse to find more files.
Of all the applets in the Control Panel, PC techs use the System applet the most. (The Windows 2000 applet looks far different. We’ll see the Windows 2000 version in Chapter 11.) You can also access this applet via My Computer’s properties (Figure 61).

- **General**  This tab tells us the version of Windows, registration information, and a few bits of information about the CPU and RAM.
- **Device Manager**  This is the most important place in the entire computer for hardware troubleshooting. We’ll see lots of this in Chapter 10.
- **Hardware Profiles**  Hardware Profiles allow us to turn off selected hardware for different system states. We see this used most often with laptops.
- **Performance**  This allows us to optimize our disk caches, swap file, and graphics settings.
Telephony
The Telephony applet, which debuted in later versions of Windows 9x, enables you to set the region, city code, and dialing preferences for dial-up networking (Figure 62). We’ll see more of this applet when we discuss modems in Chapter 17.

Users
The Users applet enables you to define multiple users of a single PC, each with his or her own personalized settings (Figure 63). We’ll discuss this more in Chapter 20.

Take Time to Review
Make sure you understand the function of each of the Control Panel applets. Also make sure that you can say on the test exactly how to access these applications. You will see some of these again in the book. Also remember that different systems can have more or fewer applets than the ones discussed in this section. My Dell laptop computer, for example, has eight applets in addition to the ones covered here, enabling me to set up everything from desktop themes to software DVD players. Explore your Control Panel!
Figure 62
Telephony applet in Windows 98

Figure 63
User Settings
The Details Will Get Ya!

Way too many techs might be tempted to fly through this chapter, assuring themselves that they “know all this stuff.” This is a dangerous attitude and one that might keep you from passing the A+ exams! CompTIA knows that you probably know the majority of these processes, so they test you on knowing the discrete steps to accomplish them. Sure you can copy a file, but do you remember what button to hold down when copying within the same drive? I sure don’t! You need to know these details or the test will get you!